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1. INTRODUCTION

The Coyote single-board computer gives OEM designers
extremely low-cost embedded control for high-volume applica-
tions. Two standard models—one with Ethernet, one without—

feature the Rabbit® 3000 microprocessor running at 29.4 MHz,
with standard 256K flash and 128K SRAM. These compact
boards are rich with the I/O (including one A/D input and two
D/A outputs) designers need for embedded control and monitor-
ing applications, and the Coyote's compact board size of 3.95" x
3.95" (100 x 100 mm) is easily mountable in standard 100 mm
DIN rail trays.

Customized BL.2500 models can be manufactured in volume in
OEM versions to user-specified configurations. Pin-compatible
RabbitCore modules allow multiple configurations of the Coyote
with Ethernet and memory options.

1.1 Features

« Rabbit 3000® microprocessor operating at 29.4 MHz (option for 44.2 MHz with
10/100Base-T Ethernet interface)

¢ 128K SRAM and 256K flash memory standard, optional 512K SRAM/512K flash

e 24 digital I/O: 9 protected and filtered digital inputs, 7 high-speed protected but unfil-
tered digital inputs, and 8 digital outputs sinking up to 200 mA at up to 36 V DC

e one 8-bit analog input channel
e two 9-bit PWM analog output channels
e six serial ports, including RabbitNet™ expansion ports

¢ one 10/100-compatible RJ-45 Ethernet port with standard 10Base-T interface (optional
10/100Base-T interface)

¢ 4 user-programmable LEDs.
¢ battery-backed real-time clock.
e watchdog supervisor.

e onboard backup battery for real-time clock and SRAM
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Two BL2500 models are available. Their standard features are summarized in Table 1.

Table 1. BL2500 Models

Feature BL2500 BL2510
Microprocessor Rabbit 3000® running at 29.4 MHz
Flash Memory 256K
Static RAM 128K"

Ethernet Connections Yes No
RabbitCore Module Used RCM3010 RCM3110
A/D Converter Input Yes Yes

* 512K options available

The BL2500 consists of a main board with a RabbitCore module. Refer to the RabbitCore
module manuals, available on Rabbit’s Web site, for more information on the RabbitCore
modules, including their schematics.

Appendix A provides detailed specifications.

Visit our Web site for up-to-date information about additional add-ons and features as
they become available. The Web site also has the latest revision of this user’s manual.

1.1.1 OEM Versions

The BL2500 and BL2510 models are also available in OEM versions as the OEM2500
and the OEM2510 (minimum quantity 500) where certain features have been removed or
eliminated:

o fewer digital inputs—only 16 digital I/O, with 8 protected and filtered digital inputs
and 8 digital outputs sinking up to 200 mA at up to 36 V DC (no header J12)

¢ no backup battery

e no RabbitNet™ hardware—no RS-422/multiplexer chips, no RabbitNet RJ-45 jacks,
no RabbitNet™ power connectors (headers J7 and J8)
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1.2 Development and Evaluation Tools
1.2.1 Development Kit

A Development Kit contains the hardware essentials you will need to use your
BL2500/OEM2500. The items in the Development Kit and their use are as follows.
e BL2500 single-board computer.

e Getting Started instructions.

e Dynamic C CD-ROM, with complete product documentation on disk.

e Programming cable, used to connect your PC serial port to the BL2500.

e 12V AC adapter, used to power the BL2500. An AC adapter is supplied with develop-
ment kits sold in the North American market. If you are using your own power supply,
it must provide 8 to 40 V DC.

e Demonstration Board with pushbutton switches and LEDs. The Demonstration Board
can be hooked up to the BL2500 to demonstrate the 1/0.

e Parts to build your own wire assemblies: wire, twenty-five 0.1" crimp terminals; ten
0.156" crimp terminals; 1 x 2, 1 x4, and 1 x 10 friction-lock connectors.

e Nylon machine screws to serve as legs for the BL2500 board during development.
e Rabbit 3000 Processor Easy Reference poster.

e Registration card.

Programming AC Adapter

Fewar] Cable = {Morth American
= kits only)

e

Nylon Machine Screws
& Nuts

PpeD
oo

M
ﬁ EF??;G Board

Friction-Lock Connectors
& Crimp Terminals

Getting Started
Instructions

Figure 1. BL2500/0EM2500 Development Kit
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1.2.2 Software

The Coyote is programmed using version 7.33 or later of Rabbit’s Dynamic C. A compatible
version is included on the Development Kit CD-ROM. Web-based technical support is
included at no extra charge. Dynamic C v. 9.60 includes the popular pC/OS-II real-time
operating system, point-to-point protocol (PPP), FAT file system, RabbitWeb, and other
select libraries that were previously sold as individual Dynamic C modules.

Rabbit also offers for purchase the Rabbit Embedded Security Pack featuring the Secure
Sockets Layer (SSL) and a specific Advanced Encryption Standard (AES) library. In addi-
tion to the Web-based technical support included at no extra charge, a one-year telephone-
based technical support subscription is also available for purchase. Visit our Web site at
www.rabbit.com for further information and complete documentation, or contact your
Rabbit sales representative or authorized distributor.

1.2.3 Connectivity Tools

Rabbit also has available additional tools and parts to allow you to make your own wiring
assemblies in quantity to interface with the friction-lock connectors on the Coyote.

¢ Connectivity Kit (Part No. 101-0581)—Six 1 x 10 friction-lock connectors (0.1" pitch)
with sixty 0.1" crimp terminals; and two 1 x 4 friction-lock connectors (0.156" pitch)
and two 1 x 2 friction-lock connectors (0.156" pitch) with fifteen 0.156" crimp termi-
nals. Each kit contains sufficient parts to interface with one Coyote board (some parts
may be left over).

e Crimp tool (Part No. 998-0013) to secure wire in crimp terminals.

Table 3 in Chapter 3 provides information on specific friction-lock connectors and crimp
terminals to be used with the various headers on the BL2500. Contact your authorized
Rabbit distributor or your sales representative for more information.
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1.2.4 DIN Rail Mounting

The Coyote may be mounted in 100 mm DIN rail trays as shown in Figure 2.

BL2500

Modular PC
Board Trays

Figure 2. Mounting Coyote in DIN Rail Trays

DIN rail trays are typically mounted on DIN rails with “feet.” Table 2 lists Phoenix Contact
part numbers for the DIN rail trays, rails, and feet. The tray side elements are used to keep
the Coyote in place once it is inserted in a DIN rail tray, and the feet are used to mount the

plastic tray on a DIN rail.

Table 2. Phoenix Contact DIN Rail Mounting Components

DIN Rail Mounting

Phoenix Contact

Phoenix Contact

Component Part Description Part Number
Trays UM 100-PROFIL cm” 1959 87 4
Tray Side Elements UM 108-SE 2959476
Foot Elements UM 108-FE 2959463

* Length of DIN rail tray in cm

NOTE: Other major suppliers besides Phoenix Contact also offer DIN rail mounting
hardware. Note that the width of the plastic tray should be 100 mm (3.95") since that is

the width of the Coyote. 108 mm plastic trays may be used with spacers.
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1.3 RabbitNet Peripheral Cards

RabbitNet™ is an SPI serial protocol that uses a robust RS-422 differential signalling
interface (twisted-pair differential signaling) to run at a fast 1 Megabit per second serial
rate. The Coyote has two RabbitNet ports, each of which can support one peripheral card.
Distances between a master processor unit and peripheral cards can be up to 10 m or 33 ft.

The following low-cost peripheral cards are currently available.

Digital I/O

A/D converter

D/A converter

Relay card
Display/Keypad interface

Appendix D provides additional information on RabbitNet peripheral cards and the Rab-
bitNet protocol. Visit our Web site for up-to-date information about additional add-ons and
features as they become available.

Coyote (BL2500)



1.4 CE Compliance

Equipment is generally divided into two classes.

CLASS A CLASS B

Digital equipment meant for light industrial use Digital equipment meant for home use

Less restrictive emissions requirement:
less than 40 dB pV/m at 10 m
(40 dB relative to 1 pV/m) or 300 uV/m

More restrictive emissions requirement:
30dB uV/mat 10 m or 100 pV/m

These limits apply over the range of 30-230 MHz. The limits are 7 dB higher for frequen-
cies above 230 MHz. Although the test range goes to 1 GHz, the emissions from Rabbit-
based systems at frequencies above 300 MHz are generally well below background noise
levels.

The BL2500 single-board computer has been tested and was found to
be in conformity with the following applicable immunity and emission
standards. The BL2510 and OEM single-board computers are also CE
qualified as they are sub-versions of the BL.2500 single-board com-
puter. Boards that are CE-compliant have the CE mark.

NOTE: Earlier versions of the BL2500 that do not have the CE mark are not CE-compliant.
Immunity

The BL2500 series of single-board computers meets the following EN55024/1998 immu-
nity standards.

e EN61000-4-3 (Radiated Immunity)

e EN61000-4-4 (EFT)

e EN61000-4-6 (Conducted Immunity)

Additional shielding or filtering may be required for a heavy industrial environment.
Emissions

The BL2500 series of single-board computers meets the following emission standards.
e ENS55022:1998 Class B

e FCC Part 15 Class B

Your results may vary, depending on your application, so additional shielding or filtering
may be needed to maintain the Class B emission qualification.
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1.4.1 Design Guidelines

Note the following requirements for incorporating the BL2500 series of single-board
computers into your application to comply with CE requirements.

General

The power supply provided with the Tool Kit is for development purposes only. It is the
customer’s responsibility to provide a CE-compliant power supply for the end-product
application.

When connecting the BL2500 single-board computer to outdoor cables, the customer is
responsible for providing CE-approved surge/lightning protection.

Rabbit recommends placing digital I/O or analog cables that are 3 m or longer in a
metal conduit to assist in maintaining CE compliance and to conform to good cable
design practices.

When installing or servicing the BL2500, it is the responsibility of the end-user to use
proper ESD precautions to prevent ESD damage to the BL2500.

Safety

All inputs and outputs to and from the BL2500 series of single-board computers must
not be connected to voltages exceeding SELV levels (42.4 V AC peak, or 60 V DC).

The lithium backup battery circuit on the BL2500 single-board computer has been
designed to protect the battery from hazardous conditions such as reverse charging and
excessive current flows. Do not disable the safety features of the design.

1.4.2 Interfacing the BL2500 to Other Devices

Since the BL2500 series of single-board computers is designed to be connected to other
devices, good EMC practices should be followed to ensure compliance. CE compliance is
ultimately the responsibility of the integrator. Additional information, tips, and technical
assistance are available from your authorized Rabbit distributor, and are also available on
our Web site at www.rabbit.com.
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2. GETTING STARTED

Chapter 2 explains how to connect the programming cable and
power supply to the BL.2500.

2.1 Preparing the BL2500 for Development

Position the BL2500 as shown below in Figure 3. Attach the four nylon 4-40 x Y4 machine
screws and nuts supplied with the Development Kit in the holes at the corners as shown.

Ay | iy
iz ) i

Module

é RabbitCore é

Figure 3. Attach Nylon Screws to BL2500 Board

NOTE: You will have to remove the RabbitCore module to install one screw under the
module. When replacing the RabbitCore module, it is important that you line up the pins
on the module exactly with the corresponding pins on the BL2500. The header pins may
become bent or damaged if the pin alignment is offset, and the module will not work.
Permanent electrical damage may also result if a misaligned module is powered up.

The nylon screws serve as standoffs to facilitate handling the BL2500 during develop-
ment, and protect the bottom of the printed circuit board against scratches or short circuits
while you are working with the BL2500.
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2.2 BL2500 Connections

1. Connect the programming cable to download programs from your PC and to program

and debug the BL.2500.

NOTE: Use only the programming cable that has a red shrink wrap around the RS-232
level converter (Part No. 20-101-0513). If you are using a BL2500 with the optional
10/100Base-T Ethernet interface, you will need the programming cable that has a blue
shrink wrap around the RS-232 level converter (Part No. 20-101-0542). Other Rabbit
programming cables might not be voltage-compatible or their connector sizes may be

different.

Connect the 10-pin PROG connector of the programming cable to header J3 on the
BL2500’s RabbitCore module. Ensure that the colored edge lines up with pin 1 as shown.
There is a small dot on the circuit board next to pin 1 of header J3. (Do not use the DIAG
connector, which is used for monitoring only.) Connect the other end of the programming
cable to a COM port on your PC. Make a note of the port to which you connect the cable,
as Dynamic C will need to have this parameter configured. Note that COM1 on the PC is

the default COM port used by Dynamic C.

NOTE: Never disconnect the programming cable

by pulling on the ribbon cable. Carefully pull on

the connector to remove it from the header. —/
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Figure 4. Programming Cable Connections
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2. When all other connections have been made, you can connect power to the BL.2500.

Connect the AC adapter to header J2 on the BL2500 as shown in Figure 5. Match the
friction lock tab on the friction-lock connector to the back of header J2 on the BL2500
as shown. The friction-lock connector will only fit one way.

Development Kits sold outside North America include a friction lock friction-lock con-
nector that may be connected to header J2 on the BL2500. Connect the leads from your
power supply to the friction-lock connector to preserve the polarity indicated in

Figure 5. The power supply should deliver 8 V-40 V DC at 500 mA.

GRS 120 D0N GOV 13 0V3 U9V 00V AEE

|
b osno000] (3

ICIRs R [T
Vel [ rs e el

e LS

I

(] OOOOOOOI”“’

:

O

b DS1

il

RS485 TERMINATION RESISTORS

z

Figure 5. Power Supply Connections
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3. Apply power.
Plug in the AC adapter.

CAUTION: Unplug the power supply while you make or otherwise work with the connections
to the headers. This will protect your BL2500 from inadvertent shorts or power spikes.

2.2.1 Hardware Reset

A hardware reset is done by unplugging the AC adapter, then plugging it back in, or by
shorting out the reset pads on the back of the BL2500 (see Figure 6).

O

RESET
pads

N\

1383y

O ©2004 Z-WORLD, INC.  175-0295 O

Figure 6. Location of RESET Pads
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2.3 Installing Dynamic C

If you have not yet installed Dynamic C version 7.33 (or a later version), do so now by
inserting the Dynamic C CD from the BL2500/OEM2500 Development Kit in your PC’s
CD-ROM drive. The CD will auto-install unless you have disabled auto-install on your PC.

If the CD does not auto-install, click Start > Run from the Windows Start button and
browse for the Dynamic C setup . exe file on your CD drive. Click OK to begin the
installation once you have selected the setup . exe file.

The online documentation is installed along with Dynamic C, and an icon for the docu-
mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the
menu. If the icon is missing, create a new desktop icon that points to default.htm in the
docs folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download
from our Web sites as well.

The Dynamic C User’s Manual provides detailed instructions for the installation of
Dynamic C and any future upgrades.

NOTE: If you have an earlier version of Dynamic C already installed, the default instal-
lation of the later version will be in a different folder, and a separate icon will appear on
your desktop.
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2.4 Starting Dynamic C

Once the BL2500 is connected to your PC and to a power source, start Dynamic C by
double-clicking on the Dynamic C icon on your desktop or in your Start menu.

Dynamic C defaults to using the serial port on your PC that you specified during installa-
tion. If the port setting is correct, Dynamic C should detect the BL2500 and go through a
sequence of steps to cold-boot the BLL2500 and to compile the BIOS. (Some versions of
Dynamic C will not do the initial BIOS compile and load until the first time you compile a
program.)

If you receive the message No Rabbit Processor Detected, the programming
cable may be connected to the wrong COM port, a connection may be faulty, or the target
system may not be powered up. First, check both ends of the programming cable to ensure
that it is firmly plugged into the PC and the programming port.

If there are no faults with the hardware, select a different COM port within Dynamic C.
From the Options menu, select Communications. Select another COM port from the list,
then click OK. Press <Ctrl-Y> to force Dynamic C to recompile the BIOS. If Dynamic C
still reports it is unable to locate the target system, repeat the above steps until you locate the
active COM port. You should receive a Bios compiled successfully message
once this step is completed successfully.

If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-
cation error message when you compile and load a sample program, it is possible that your
PC cannot handle the higher program-loading baud rate. Try changing the maximum
download rate to a slower baud rate as follows.

¢ Locate the Serial Options dialog in the Dynamic C Options > Communications
menu. Select a slower Max download baud rate.

If a program compiles and loads, but then loses target communication before you can
begin debugging, it is possible that your PC cannot handle the default debugging baud
rate. Try lowering the debugging baud rate as follows.

¢ Locate the Serial Options dialog in the Dynamic C Options > Communications
menu. Choose a lower debug baud rate.
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2.5 PONG.C

You are now ready to test your set-up by running a sample program.

Find the file PONG. C, which is in the Dynamic C SAMPLES folder. To run the program,
open it with the File menu (if it is not still open), compile it using the Compile menu, and
then run it by selecting Run in the Run menu. The STDIO window will open on the PC
and will display a small square bouncing around in a box.

This program shows that the CPU is working. The sample program described in
Section 5.2.3, “Run the PINGME.C Demo,” tests the TCP/IP portion of the board.

2.6 Where Do | Go From Here?

NOTE: If you purchased your BL2500 through a distributor or Rabbit partner, contact
the distributor or partner first for technical support.

If there are any problems at this point:
¢ Use the Dynamic C Help menu to get further assistance with Dynamic C.

¢ Check the Rabbit Technical Bulletin Board and forums at www.rabbit.com/support/bb/
and at www.rabbit.com/forums/.

e Use the Technical Support e-mail form at www.rabbit.com/support/.

If the sample program ran fine, you are now ready to go on to explore other BL2500 fea-
tures and develop your own applications.

Chapter 3, “Subsystems,” provides a description of the BL2500’s features, Chapter 4,
“Software,” describes the Dynamic C software libraries and introduces some sample pro-
grams. Chapter 5, “Using the TCP/IP Features,” explains the TCP/IP features.
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2.7 Using the Coyote In High-Vibration Environments

If you plan to use your Coyote in a high-vibration environment, the RabbitCore module
may be secured more solidly to a swage on the Coyote main board using a 2-56 x %"
machine screw as shown in Figure 7.

S

+

T e
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/

Figure 7. Secure RabbitCore Module to Coyote for High-Vibration Environments
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3. SUBSYSTEMS

Chapter 3 describes the principal subsystems for the Coyote.

* Digital I/0

* Analog Features

* Serial Communication
* Memory

Figure 8 shows these Rabbit-based subsystems designed into the Coyote.

Digital
Inputs
Digital
SRAM ] Outputs
Flash
I
Converter
Ethernet
(BL2500/BL2550)
. Analog *
RabbitCore Module Outputs i}

Figure 8. Coyote Subsystems

The memory and microprocessor are located on the RabbitCore module. If you have more
than one Coyote or other Rabbit products built around RabbitCore modules, take care not
to swap the RabbitCore modules since they contain system ID block information and cali-
bration constants that are unique to the board they were originally installed on. It is a good
idea to save the calibration constants should you need to replace a RabbitCore module in
the future. See Section 4.2.6, “Using System Information from the RabbitCore Module,”
for more information.
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3.1 Coyote Pinouts

The Coyote pinouts are shown in Figure 9.
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Figure 9. Coyote Pinouts
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3.1.1 Headers

Standard Coyote models are equipped with five 1 x 10 friction-lock connector terminals
(J1,J3,J9,J11, and J12) where pin 9 is removed to polarize the connector terminals, a 2 X 5
RS-232 signal header, a 2 x 5 programming header, and an RJ-45 Ethernet jack on the
RabbitCore module.

The RJ-45 jacks at J4 and J5 labeled RabbitNet are serial I/0 expansion ports for use with
digital I/O and analog I/O boards currently being developed. The RabbitNet jacks do not
support Ethernet connections. Be careful to connect your Ethernet cable to the jack labeled
Ethernet.

Two 4-pin 0.156" friction-lock connector terminals at J7 and J8 are installed to supply
power (DCIN and +5 V) to the peripheral cards currently being developed for use with the
RabbitNet. Two 2-pin 0.156" friction-lock connector terminals at J2 and J10 are for power
supply and +K connections.

Table 3 lists Molex connector part numbers for the crimp terminals, housings, and polarizing
keys needed to assemble female friction-lock connector assemblies for use with their male
counterparts on the BL2500.

Table 3. Female Friction-Lock Connector Parts

Friction-Lock | Used with BL2500 | Molex Housing Molex Molex
Connector Headers Part Number | Crimp Terminals | Polarizing Keys
0.1"1x10 J1,J3,J9,J11, J12 22-01-2107 08-50-0113 15-04-9209
0.156" 1 x4 J7,78 09-50-3041

08-50-0108 15-04-0219
0.156" 1 x 2 12,710 09-50-3021
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